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RISK OF ELECTRIC SHOCK
DO NOT OPEN
RISQUE DE CHOC ELECTRIQUE
NE PAS OUVRIR

it CAUTION it

CAUTION: TO REDUCE THE RISK OF ELECTRIC SHOCK
DO NOT REMOVE COVER (OR BACK)
NO USER-SERVIDEABLE PARTS INSIDE
REFER SERVICING TO QUALIFIED PERSONNEL

ATTENTION: POUR EVITER LES RISQUES DE CHOC
ELECTRIQUE: NE PAS ENLEVER LE COUVERCLE. AUCUN
ENTRETIEN DE PIECES INTERIEURES PAR L'USAGER CONFIER
L'ENTERETIEN AU PERSONNEL QUALIFIE.

The lightning flash with arrowhead symbol within an
equilateral triangle.is intended to.alert the user to the
presence of uninsulated dangerous voltage within the
products enclosure, that may be of sufficient magnitude to
electric shock to persons. Le symbol.clair avec point de fl
che lintrieur d un triangle quilat ral est utilis pour alerter
| utilisateur de la pr sence | int rieur du coffret de vottage
dangereux non isol d ampleur suff

on point within an triangle is
intended to alert the user of the presence of important
operating and maintenance (serviving) instructions in the
literature accompanying the appliance. Le point
dexclamation lint rieur d un triangle quilat ral est employ

AVIS: POUR EVITER LES RISQUES D'INCENDIE OU
D'ELECTROCUTION, N EXPOSEZ PAS CET ARTICLE
ALAPLUIE OU ALHUMIDITE

pour alerter les utilisateurs de la prsepce d instructions
importantes pour le fonctionnement et | entretien (service)
dans le livret d instruction accmpagnant | appari |.

Important Safety Instructions

1.

10.

11.

12.

13.

14.

Read this manual thoroughly before using this unit.
Keep this manual for future reference.

Take notice of and comply with all warnings included in the user's manual or indicated on the
appliance.

Follow all instructions included in this manual.

Do not expose this unit to rain or moisture. Avoid having water or other liquids spilled on this
unit.

When cleaning the cabinet or other parts of this appliance, use only a dry or slightly damp soft
cloth.

Do not block any ventilation openings or interfere with the proper ventilation of this unit. Install
in accordance with the manufacturer's instructions.

Do not use or store near any heat sources such as radiators, heat registers, stoves, or other heat-
producing appliances.

Do not interfere with the safety purpose of the polarized or grounding-type plug. A polarized plug
has two blades with one wider than the other. A grounding-type plug has two blades and a third
grounding prong. These are designated for your safety. If the provided plug does not fit into your
outlet, consult an electrician.

Protect the power cord from being walked on or otherwise damaged by items placed on or
against them. Particular attention should be given to the plugs, receptacles, and the point where
the cord exits the appliance.

To avoid the risk of electrical shock, do not touch any exposed wiring while the unit is in
operation.

Only use attachments/accessories specified by the manufacturer.

Unplug this unit and all connected electrical equipment during lightning storms or when left
unused a long period of time.

Refer all servicing to qualified service personnel. Servicing is required when the appliance has
been damaged in any way or fails to operate normally.

WARNING: To reduce the risk of fire or electric shock, do not expose this unit to rain or moisture
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Introduction

Firstly, congratulations on your purchase of the ICON Pro Audio UPorts2 Dyna digital
audio Interface! In these pages, you'll find a detailed description of the features of
the UPorts2 Dyna digital audio Interface, as well as a guided tour through its front
and rear panels, step-by-step instructions for their setup and use and a full list of
specifications. As you read through the ma- nual, you will spot orange boxes - these
denote actions for you to complete which will help you get underway.

As with most electronic devices, we strongly recommend you retain the original
packaging. In the unlikely event that the product is returned for servicing, the original
packaging (or reasonable equivalent) is required. With proper care and adequate air
circulation, your UPorts2 Dyna digital audio interfacewill operate flawlessly for many
years to come.

We trust that this product will provide years of excellent service and in the unlikely

event that your product does not perform to the highest standard, every effort will be
made to address the issue.

What’s in the package?

UPorts2 Dyna USB Recording Interface
Quick Start Guide x 1

USB 2.0 cable (Type C) x 1

3.5mm TRS audio cable x 1



Register your ICON ProAudio product to your
personal account
1. Check serial number of your device

Please go to http:// iconproaudio.com/registration or scan the QR code
below.

Input your device’s serial number and the other information on the screen. Click
“Submit”.

A message will pop up showing your device information such as model name
and its serial number - Click “Register this device to my account” or if you see
any other message, please contact our after-sales service team

2. Log in to your personal account page for existing user or

sign up for new user
Existing user: Please log into your personal user page by inputing your
user name and password.

New user: Please click “Sign Up” and fill in all the information.

3. Download all useful materials
All your registered devices under your account will show on the page. Each
product will be listed along with all its available files such as drivers, firmware,
user manual in different languages and bundled software etc. for download.
Please make sure you have download the necessary files such as driver before
you begin device installation.



Features

The ICON ProAudio UPorts2 Dyna USB recording interface provides an audio input
and output module as well as analog & digital connectivity with any smart mobile
devices for live streaming applications. Main features include:

24-Bit 192KHz 1 mic-In/1 inst-In, 2-Out USB Recording Interface

Hi-end studio grade DAC/ADC provides super high dynamic range
Dynamic Range: 127dB

Supporting Mac/PC connectivity operating simultaneously with SmartDevice
Live session possible with audio signal processing via ProDriver4 virtual plug-in rack
2x2 analog I/O full duplex recording and playback

Compatible with iOS and Android Digital 1/0 jack (Type C) & Analog I/O jack (3.5mm
stereo TRRS)

For direct connection with smartphone, tablet or other device

Mic/Instrument preamps with individual gain control and phantom power switch
2 analog outputs on 1/4” TS jacks or stereo output on 3.5mm phone connector
Smart phone input level control on the top panel

Direct monitor button control on the top panel

1 headphone output with assignable source and individual volume control
Flexible channel routing via the ProDriver4 software control panel

ICON ProAudio developed ultra low latency ProDriver4 ™driver is provided

ICON ProAudio innovative and user friendly plug-in hosting rack software is built-in
with ProDriverd™ (Windows and Mac)

USB2.0 High Speed equipped and USB bus-powered

ARM-M7/500MHz processing power and technology for super fast and stable signal
processing

Supports Direct Sound, WDM and ASIO2.0

LoopBack function is equipped with ProDriver 4™ for both Mac and Windows
platforms

Compatible with mac OS (M1/ Intel Mac) 10.11 and later, iOS 9 or above, Andriod
and Windows 7, 8 & 10 (32-bit/64-bit)

Full duplex, simultaneous record/playback



+5VDC power supply connector is equipped for external power supply when using
with iOS

Rugged aluminum construction

Bitwig 8Track included

Dotec audio plugins included



Front Panel
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1. 3-pin XLR (Balanced) — For condenser microphone with +48V

phantom power or dynamic microphone.
Please refer to P.26 for the connection method of different types of microphones
and instruments.

1/4” TS (Unbalanced) — For dynamic microphone
Please refer to P.26 for the connection method of different types of microphones.

2. 48V phantom power switch
Press to supply +48V phantom power to the associated XLR input. This phantom
power circuit is suitable for most condenser microphones.

3. Input gain level control (Microphone)
This potentiometer controls the input level of the analog microphone input.

4. Input gain level control (Guitar)
This potentiometer controls the input level of the instrument input.

5. Headphone level control
This potentiometer controls the output level of the headphone output.

6. Headphone output

This output jack accepts a standard 1/4" stereo TS headphone connector.

7. Mon (Monitor — Control smart phone & PC monitoring signal)
Switch between monitoring smart device with PC signal or only PC’s signal
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USB2.0 High-Speed

USB 2.0 connector (Type C)

Connect it with the provided USB cable Type C to your Mac/PC or your
iOS device camera kit's USB connector. Your Mac/PC must have a USB2.0
connector in order to run the full speed of UPorts2 Dyna .

HI-Z input

This is a high impedance input for guitar/bass.

Line outputs L/R

These are unbalanced analog outputs on standard 1/4" TS connectors at +6dBU
line level.

Stereo output L/R
This is an unbalanced analog output on a standard 3.5mm stereo connector.

(Note: Master level control will only adjust the output level of both the Line
output 1/2 and the 3.5mm stereo output.)

Smart Device I/O (Digital - Type C & Analog - 3.5mm TRRS)
These ports allow you to connect your smart device and your Mac/PC
simultaneously so you may process the audio signal with your Mac/PC before
delivering signal to the smart device for live streaming application.

Digital - Type C jack for connecting directly to the digital jack of the smart
device (OTG adapter raquired)
Analog - TRRS stereo jack for connecting directly to smart device’s audio 1/0

Power supply connector (USB Type C)

UPorts2 Dyna is USB-bus powered. If your computer does not supply sufficient
power, connect an ICON 5VDC power supply adapter to this jack. Or you may
try to use your smart phone power adapter with the correct cable type (Android).
Normally it should work and provide enough power to the device.

(Note: You can get the power adapter from ICON distributors/dealers near you)

(Note: External power adapter is needed if the UPorts2 Dyna is use as a
standalone unit without a Mac or PC)



Top Panel
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1. Direct Monitor button
Press to monitor the input signal (i.e. microphone or instrument) through your
headphones. Pressing In will allow for Direct monitoring of signal mean signal
without computer processing.

2. Smart Phone Input Level Control

Adjust to control the audio input level to the smart phone.

3. Master Level Control
Master level control will only adjust the output level of both the Line output 1/2
and the 3.5mm stereo output.



Mac driver installation

UPorts2 Dyna is a class compliant device. Thus there is no driver installation
needed for Mac. Also, it fully supports iOS devices by connecting the unit to a

camera kit.

Install ProDriver 4 with LoopBack function

1. Download ProDriver 4 (Mac) from your "Personal User
Portal” page for your audio intetface.

(Please refer to P.5 "register your ICON ProAudio product to your personal

account” for creating your persoanl user portal)

2. Double click the file "ProDriver-OSX-xxx.dmg" that you just
downloaded from your Persoanl User Portal

r
(]

([ ] [ icol

ProDriver.pkg

N ProDriver

Extras

Diagram 1

3. Double click "ProDriver.pkg" to start the ProDriver installation

[ ] [£) icON ProDriver

A S
—_— )
ProDriver.pkg

Extras

Diagram 2
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4. Click "Continue"

® Introduction

Welcome to the ProDriver Installer

You will be guided through the steps necessary to install this
software.

5.

6.

Click "Continue"

Click "Read License" to
read the lincense terms
or click "Agree" to start
the installation

Select the disk where
you would like ProDriver
to be installed and then
click "Continue"

Diagram 3

L[] & Install ProDriver

Software License Agreement
English (<]

DRIVER SOFTWARE LICENSE AGREEMENT FOR ICON USB Audio
Interface ("PRODUCT")

Introduction

® Licence

IMPORTANT NOTICE - PLEASE READ CAREFULLY:

This Software License Agreement ('SLA") is a legal agreement between
you (either an individual or a single entity) and ICON Digital Gorp.
('ICON").

By instaling, copying, or otherwise using the PRODUCT, you agree to
the terms and conditions of this SLA. If you do not agree to the terms of
this SLA, do not install or use the PRODUCT.

SOFTWARE LICENSE

The PRODUCT is protected by copyright laws and interational copyright
treaties, as well as other intellectual property laws and treaties. The
SOFTWARE contained herein is licensed, not sold.

1. GRANT OF LICENSE. This SLA grants you the following rights:
You may install and use the SOFTWARE, or any prior version for the.

GoBack | Conti E

Print... Save...

Diagram 4

e S DT

To continue installing the software you must agree to the terms of the
software license agreement.

Click Agree to continue or click Disagree to cancel the installation and quit
the Installer.

Read Licensa. Disagree Agree

= ,

Diagram 5
° & Install ProDriver
Select a Destination
e Select the disk where you want to install the
ProDriver software.
Licence

® Destination Select

Macintosh HD NO NAME Seagate...kup Drive
87.15 GB available 7488 MBavaikble  410.65 GB available
250.69 G total 2.02 GB total 999.49 GB total

Installing this software requires 327 MB of space.

You have chosen to install this software on the disk
“Macintosh HD".

GoBack | Continue 1

Diagram 6 S~_



(] @ Install ProDriver

8 - C I i ck " I nsta I I " Standard Install on “Macintosh HD"

Introduction ‘This will take 32.7 MB of space on your computer.

Licence Click Install to perform a standard installation of this software

Destination Select on the disk “Macintosh HD".

© Installation Type

Change Install Location...

Go Back Install ;
Diagram 7 ~_

9- InPUt your passw_ord or ,\\\ Installer is trying to install new software.
tap your flnger prl nt to 0@_{\\—% Touch ID or enter your password to allow this.
. . \ 7 Y
start the installation. * T el

Diagram 8

& Install ProDriver

1 0 . I nsta I Iti on Sta rted a nd The installation was completed successfully.

Introduction

click "Close" after it has @

Destination Select

completed.

Installation The installation was £
ul.
© summary

The software was installed.

Close

Diagram 9 S

11. Please connect your audio

ProDri
interface at this state to you Mac

and then click the ICON logo as
shown.

Diagram 10 \ ‘
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13.

14.

15.

Select your audio interface Did not find an iCON device
mOdeI from the I|St and Please choose your Audio Interface from the list.
CI |CK useleCt" ProDriver: Pro Driver: UPortsZ

Diagram 11 S
Click "OK" to allow
. ?

ProDriver to access the sl :
microphones. ‘\@)

“ProDriver” would like to access

the microphone.
This app requires audio input. If you do
not have an audio interface connected it
will use the built-in microphone.
e
Diagram 12 \r

ProDriver activate logo will 0

appear on your desktop
and click it to launch the \ )
=

ProDriver control panel. )
Diagram 13

L Uports2Dyna (Core Audio)
Clock Source: Default

Audio MIDI setup

Open the “Audio MIDI setup” window and
confirm that the UPorts2 Dyna device has
been setup properly as shown in diagram

14,

e Outout |
Source: Uports2 Dyna: Output

PSP
device...

- ger
Configure speakers... 2

Vaue o8

4
[ e T
Play alerts and sound effects through this device

out2

Diagram 14



Mixer control panel(Mac)

The mixers work like a matrix mixer. Activate and adjust the corresponding input or output
channel level. They are very useful and make your inputs and outputs very flexible. You may
route any of your input(s) to any output(s).

LINK

Diagram 15

1. HW In 1/2 level metering
Shows the hardware 1/2 input level. (HW In 1/2).

2. HW Out 1/2 level metering
Shows the hardware 1/2 output level.(HW Out 1/2).

3. LoopBack In 1-8 level metering
Show the LoopBack 1/2, 3/4, 5/6 & 7/8 input level

4. LoopBack Out 1-8 level metering
Show the LoopBack 1/2, 3/4, 5/6 & 7/8 output level

5. Link switch

Switch to adjust both channels' levels simultaneously.

6. Mute switch

Switch to mute the corresponding channel.

7. “0dB” switch

Switch to instantly adjust the corresponding channel to “0dB” level.

8. Gain control fader
Slide to adjust the gain level for the corresponding channel.

9. Inputs & Outputs Matrix switches

Switch to turn On/Off the corresponding input channel route to the corresponding
output channel. Remember you may route any input(s) to any output(s).

10. Mixer Presets
6 Mixer-Presets button slots are available for saving or loading your routing
channel settings.

15
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Audio
MIDI

General

v | HWout 1+2

v | HWout 3+4
Active output channels:

v | LoopBack 1+2

v | LoopBack3+4

v | HWin 1+2

v | HWIn 3+4
Active input channels:

v | LoopBack 1+2

v | LoopBack 3 +4

1.5 Samplerate: 44100 Hz

1.6 Audio buffer size: 1024 samples (23.2 ms)

Diagram 16

11. Device Preferences
Click "Device" at the top menu bar to launch the "Preferences" window.

11.1 Output
Select your audio interface as your output device

11.2 Input
Select your audio interface as your input device

11.3 Active output channels
Showing you all the avaliable and active output channels for your audio interface

11.4 Active output channels
Showing you all the avaliable and active input channels for your audio interface

11.5 Sample rate
Select your desire sample rate from the list

11.6 Audio buffer size
Select your desire audio buffer size from the list

(Note: If a clicking sound occurs, you should change to a larger buffer size
for the settings. If the largest buffer size has been selected and there is still a
clicking sound. It means your computer performance is not able to handle the
task. (It is not caused by UPorts2 Dyna digital audio interface.)



Windows driver installation

Please follow the step-by-step procedures below to install your UPorts2 Dyna USB
recording interface and its driver.

1.

3. Installation Wizard appears

4,

Turn on your computer

Note: Do not connect the UPorts2 Dyna digital audio interface to your computer

yet.

Download the Windows driver from your “Personal User
Page at www.iconproaudio.com” (Please refer to Diagram 6

for instruction)

After you downloaded the driver file, please click it to start the installation

process.

Uports2 Dyna

Serial Number: E13jbmikams &

Latest driver for MacOS

Latest driver for Win32

Latest driver for Win64

V1.1.0

V110

V1.1.0

Choose "Next" when you see the Welcome

Screen shown in Diagram 7.

License Agreement
Click “I Agree” to proceed.

Unregister
this device

Diagram 17
s/ ICON Pro Driver4 Setup o] & w3

Welcome to the ICON Pro Driver4
Setup Wizard

vl guide you through the installation of ICON

make it possible to update

Click Next to continue.

(@I
Diagram 18
s/ ICON Pro Driver4 Setup. o] & w3
et et o e et i K v ™

Press Page Down to see the rest of the agreement.

RIVER SOFTWARE LICENSE AGREEMENT FOR ICONl Us8 Audlo Interfoce B
(ceRopUCT) =

[MPORTANT NOTICE - PLEASE READ CAREFULLY:

IThis Software License Agreement ("SLA")is a legal agreement between you (either an
Iindnidual or a single entity) and ICON Digital Corp. ("ICON").

Iy installing, copying, or otherwise using the PRODUCT, you agree to the terms ant
lconditions of ths SUA. I you do not agree to the terms of this SLA, do not nstal or

nt, click T Agree to continue. You must accept the

o)

Diagram 19

17
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5. Select components for installation

Check mark the components that you would
like to install. We strongly recommend that
you select all components.

Preparing installation files

Once the installation process has started,
the process may take some time depending
on your computer performance. Please be
patient and wait for the process to finish.

Click “Install” to proceed.

Note: The same message will appear three
times as there are three different driver
installations.

sl ICON Pro Driverd Setup o B e
Choose Components.
Choss whehfstures o CON Pro Drverd you vant o sl o
ok the instal and uncheck the dont ant to
instal. Ciick Intal t0 tart the intalaton.
Select components to install “”“”W""

UPorts2 Dyna Device Drivers.
Desktop Shortcut
Start Menu

Space required: 20.8M8

e et 3 [ ]

Diagram 20

s ICON Pro Driverd Setup ol B 2
Installing —
icas wak wie CON Pro Drer s g ntaled. o

(Emcme. C:\Users\chris\AppDatal\Local\Temp\lconDriver\con_UParis2 Dyna_2.9.86 50.0xe )

Diagram 21

| Windows Security
Would you like to install this device software?

G Nome: ICON ProAudio Sound ideo and game cont
(&) publisher: ICON ProAudio

7] Always trust software from “ICON ProAudi”. DontInstall

@ You should only install driver software from publishers you trust. How can
decide which device software is safe to install?

Diagram 22
| Windows Security

Would you like to install this device software?

(7 Neme: ICON ProAudo Sound,video and game contro
‘\;j) Publisher: ICON ProAudio

[ Atways trust software from ‘ICON ProAudio”. Install ) [ Don'tInstall

@ You should only install driver software from publishers you trust. How can]
decide which device software is safe to install?

Diagram 23
| Windows Security

Would you like to install this device software?

(7 Neme: ICON ProAudio Sound,video and game contro
‘\;j) Publisher: ICON ProAudio

[ Atways trust software from ‘ICON ProAudio”. Install )} [ Don't Install

@ You should only install driver software from publishers you trust. How canl
decide which device software is safe to install?

‘Diagram 24



8 ICON Pro Driverd Setup o] @ | 8

8. Setup completed
A window as shown in Diagram 25
should appear. Choose "Finish”.

Completing the ICON Pro Driver4
Setup Wizard

1CON Pro Driverd. has been installed on your computer.

Cllck Finish to close this wizard.

]Launch Control Fanel

Diagram 25

9. Launch the software

control panel

You may click the ICON ProAudio
logo on the system tray to launch
the software control panel (Page 20).

10. Connect your UPorts2
Dyna digital audio
interface
Now connect the UPorts2 Dyna

digital audio interface to your
computer's USB port.

Diagram 27



ProDriver4(Windows)
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LINK LINK LINK LINK LINK

Diagram 17

Diagram 18

Introducing ProDriver, the leading edge in audio innovation for stage, studio and
streaming from iCON ProAudio. The ProDriver audio system supplys you with the
most reliable tools for almost any audio application, in the moment, right when you
need it. The heart of the system, is our driver, employing breakthrough technology
and zero latency monitoring. The user interface makes it easy to grab, route and
redirect audio from any source in your computer with our virtual signal router. Use
the ProDriver Plugin Host to connect your favorite VST, Audio Units and Direct X
plugins. Run ProDriver in standalone mode or with your favorite DAW. Save your
favorite plugin chains as presets and recall them during your session or live on stage
in real time.



Mixer control panel(Windows)

There are two different audio drivers including “WDM” (Windows Driver Model) and “ASIO”
(Audio Stream Input and Output) within the ICON ProAudio audio interface driver. WDM

are widely used for daily software such as media player and ASIO is mainly being used for
most of the recording software such as LogicPro. The advantage of ASIO is that it has much
lower latency than WDM and this is very important when you are doing recording with load
of plugins. Actually, most of the daily software does not support ASIO driver and using WDM
only, in that case you just simply need to use the HW channel (Hardware channels). Below
please find some explanations on the different terminology for each channel type.

1. HWIN (Hardware Channel IN)
This mean the hardware input channels including the microphones or internment

input channels

2. HW Out (Hardware Channel OUT)

This mean the hardware output channels including the headphone or line out output
channels

3. VC Out (Virtual Channel OUT)
This only exists on ASIO driver and it is a virtual channel that its output signal go to
ASIO VC IN

4. VC Out (Virtual Channel IN)

This only exists on ASIO driver and it is a virtual channel that its input signal is
coming from ASIO VC Out

5. LoopBack (LoopBack Channel)
ASIO internal loopback channel (e.g. ASIO VC Out signal go to ASIO VC IN)

On the mixer control panel, there are four different types of ASIO channels that you can
manipulate.

1. UPorts2 Dyna Hardware channels (HW In 1/2 & HW Out 1/2)

These are the hardware input and output channels on UPorts2 Dyna .

2. UPorts2 Dyna Virtual channels (VC In 1/2, 3/4 and 5/6), (VC Out
1/2, 3/4 and 5/6)

These are the input and output virtual channels that related to the WDM.
For example: WDM Out 1/2 linked to VC In1/2
VC Out1/2 linked to WDM In1/2

3. UPorts2 Dyna Loopback channels (LB 1/2, 3/4 and 5/6)
These are the ASIO loop-back channels.

21
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LINK LINK LINK LINK

Diagram 19

By activating different cross points, you may route the corresponding signal to your
desired channels.

HW Input 1/2 level metering
Showing the hardware 1/2 input level (HW In 1/2).

HW Output 1/2 level metering
Showing the hardware 1/2 output level (HW Out 1/2).

. VCIn 1/2 (Virtual) input level metering

Showing the WDM 1/2 output level (VC In 1/2).

VC In 3/4 (Virtual) input level metering
Showing the WDM 3/4 output level (VC In 3/4).

VC Out 1/2 (Virtual) output level metering
Showing the ASIO 1/2 VC output level (VC Out 1/2).

. VC Out 3/4 (Virtual) output level metering

Showing the ASIO 3/4 VC output level (VC Out 3/4).

VSC In 1/2 (Virtual) input level metering
Showing the WDM 1/2 output level (VSC In 1/2).



8. VSC Music In 1/2 (Virtual) input level metering
Showing the WDM 1/2 output level (VSC music In 1/2).

9. VSC Out 1/2 (Virtual) output level metering
Showing the ASIO 1/2 VC output level (VSC Out 1/2).

10. VSC Music Out 1/2 (Virtual) output level metering
Showing the ASIO 1/2 VC output level (VSC music Out 1/2).

11. Loopback 1/2
Showing the ASIO loop-back 1/2 channel’s level metering.

12. Loopback 3/4
Showing the ASIO loop-back 3/4 channel’s level metering.

13. Loopback 5/6
Showing the ASIO loop-back 5/6 channel’s level metering.

14. Link switch

Switch to adjust both channels level simultaneously.

15. Mute switch

Switch to mute the corresponding channel.

16.“0dB” switch
Switch to instantly adjust the corresponding channel to “0dB” level.

17. Gain control fader
Slide to adjust the gain level for the corresponding channel.

18.Inputs & Outputs Matrix switches

Switch to turn On/Off the corresponding input channel route to the corresponding
output channel. The matrix is very useful and makes your inputs and outputs very
flexible. You may route any of your input(s) to any output(s).

19. Mixer Presets

6 Mixer-Presets button slots are available for saving or loading your routing
channel settings.

23
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Settings (Sample rate and latency settings)

Click the “Setting” button to launch the settings window.

pro0res 4001 S |-

Diagram 20

Sample rate setting
Select your desired sampling rate from 44.1KHz to 192KHz on the pull down
window shown in Diagram 21.

Provives 00.1 |

Diagram 21



Latency settings

There are six standard latency settings to select. If you would like to customize
your own latency value, select custom.

o Safe (maximum latency)

o Extra Large

o Normal

e Small

e Very Small

o Minimum (minimum latency)

e Custom

ProDrive4 4.0.0.

Diagram 22
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There are three different settings you can adjust to customize your own latency
settings: These values include:

ASIO buffer Size
You may adjust the value ranging from 32/64/128/256/512/1024/2048 and 4096.

ProDrive4 4.0.0.

Diagram 23

Streaming buffer Size
Adjustable settings: Minimum/Low/Normal/High and Maximum.

ProDrive4 4.0.0.

Diagram 24



3. Streaming buffer volume
Adjustable values: 2/3 and 4.

ProDrived 4.0.0.

Diagram 25

Diagram 26

(Note: If a warning message appears on the “Latency Status” windows, please
select a larger latency setting.)

(Note: If a clicking sound occurs, you should change to a larger buffer size
for the settings. If the largest buffer size has been selected and there is still a
clicking sound. It means your computer performance is not able to handle the
task. (It is not caused by UPorts2 Dyna digital audio interface.)
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ProDriver4 hosting rack (Mac/Windows)

[ ] Pro Driver - Mixer

v 2 Dyn: :
ple Rate: u 4 LINK LINK LINK LINK LINK

gine: Running

CON WOW12  loopBackiR  LoopBack¥4  LoopBacks/s  LoopBackTs

Analog Out  Loopbacks

Diagram 38

With the ProDriver Rack, you can use any of your plug-ins with your DAW. Or you
may use your device as a standalone plug-ins effectors without the need to run a
DAW.

Click the "Rack" button on your ProDriver's mixer panel to launch the Virtual Rack
window



Session & Preset
A session could contain unlimited presets. Each preset allow you to insert
different plug-ins to create your desire sound effect or application need.

B Pro Driver - Rack - m} *

Diagram 39

1. Create a New Session
Click "New Session" under the "file" tab on the top menu bar. Then click "Save
Session" and input file name.

2. Open a saved Session
Click "Open Session" under the "File" tab on the top menu bar and select the
saved session file to open the session.

3. Save a Session
When you make any changes to your session, you may save it by clicking the
"Save Session" function under the "File" tab on the top menu bar. Or if you
would like to save as a new session, click "Save Session As" function and input
a new session name.

Create a New Preset
Click "New Preset" function under the "Edit" tab on the top menu bar. A new
preset slot will create.
Tip: To rename the preset, click the "Aa" button on the selected preset slot.

B8 Pro Driver - Rack

= Pro Driver - Rack = [m] X

All Presets

Diagram 40
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Duplicate Current Preset
Sometime you may like to make small changes to a current preset and compare
the two. The function of "Duplicate Current Preset" will allow you to copy the
current preset instantly. Then you may make changes as wish with one of the
preset and make comparison between the two. Click "Duplicate Current Preset"
function on the "Edit" tab on the top menu bar.
Tip: You may duplicate a selected preset by clicking the third button on the right
on the selected preset slot.

8 Pro Driver - Rack = [m] *

Diagram 41

Delete a Preset
You may delete any preset. Select a preset and click "Delete selected preset"
under the "Edit" tab on the top menu bar.
Tip: You may also delete a selected preset by clicking the "Trash" button on the
selected preset slot.

B8 Pro Driver - Rack - [m] *

Diagram 42



Grouping a Preset

There are four "Preset Categories" including "Vocal", "Special", "MC" and
"Others" that allow you grouping all your current presets. This is very useful to
manage your different presets according to different application such as singing
(Vocal), broadcasting (MC) or Guitar (Special) etc. To set a selected preset to a
particular category - Click the "#" button in the selected preset slot and click the
category from the pull down menu.

All Presets

#l Pro Driver - Rack - O X

All Presets

Diagram 43
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Diagram 44

Edit plug-in in a preset
Click the "Pencil & Paper" button on the selected preset slot will enter to the
plug-in rack screen where you would see 6 different routing blocks.

1. ProDriver Input routing block with orange connections
Depended on the number of I/O that your audio interface equipped, you will see
a number of connections in orange, they are representing the input channels of
the audio interface.

2. ProDriver Output routing block with orange connections
Depended on the number of 1/0 that your audio interface equipped, you will see
a number of connections in orange, they are representing the output channels of
the audio interface.

3. ProDriver MIDI Input routing block with green connection
Depended on if your audio interface has equipped with MIDI 1/O, you will see
a connection in green, it is representing the MIDI input channel of the audio
interface.

4. ProDriver MIDI Output routing block with green connection
Depended on if your audio interface has equipped with MIDI 1/O, you will see
a connection in green, it is representing the MIDI output channel of the audio
interface.



5. Mute routing block

This is a routing block intended for the use of Mute function. Right click the
block will show up the plug-in pull-down menu for all the available plug-in, click
the desire plug-in to select. To use the block as the "Mute" function, normally
you have to add . We have created a small activate shortcut button on the
ProDriver floating icon. Simply click the "M" button would activate or deactivate
the function (plugin).

Tip: Except using it as a Mute function, you may consider to use it for any other
function that you wish by insert a correspondence plugin.

Diagram 45

6. Voice Over routing block

This is a routing block intended for the use of Voice Over function. Right click
the block will show up the plug-in pull-down menu for all the available plug-in,
click the desire plug-in to select. To use the block as the "Voice Over" function,
normally you have to add . We have created a small activate shortcut button

on the ProDriver floating icon. Simply click the "V" button would activate or
deactivate the function (plugin).

Tip: Except using it as a Voice Over function, you may consider to use it for any
other function that you wish by insert a correspondence plugin.
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Import all your available plug-in

To import all you available plug-in, click "View" tab on the top menu bar and click
"Plugin Manager" to launch the Plugin Manager window. Click "Scan VST" or
"Scan VST3" to scan your computer all the available correspondence plugin
automatically. A list of all available plugins will be shown and they have imported
automatically and ready to be used in ProDriver.

#® Pro Driver - Rack

B Pro Driver - Rack

All Prese!

Select folders to scan...

Diagram 46



Add plug-in and make routing
It is extremely easy to add plug-ins and make any routing between input
channels to any plug-in to output channels. Just simply pull & drag the
connection cable from connection point to point. To add a plug-in, right click your
mouse, you will see all the available plug-ins that you have in your computer in
the pull-down menu, then simply just click the plug-in to select.

Dry)
Lowpass Cutoff Frequency

Diagram 47

Buttons
1. Click to launch the actual plug-in control panel for making settings.
2. Click to delete all the virtual connections that connected to the block.
3. Click to delete the routing /plugin block
4. Click to activate or deactivate the routing/plugin block

Diagram 48
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Hardware Connections

Connect the UPorts2 Dyna digital audio interface outputs to your amplifier, powered

monitors.

If you are monitoring through headphones, connect your headphones to the
device's headphone output.

Connect your microphone/guitar to the device's analog input.

PC/MAC Only
Mac / PC A
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Power Pack
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iPad
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Mac / PC
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Different types of microphone connection
method diagram

Dynamic
Microphone
(D2)

1/4” TR
Unbalanced

Balanced

Condenser
Microphone
(Apollo)

Note: For dynamic microphone user, please make sure +48V phantom power switch
is “OFF” before you plug in your microphone, otherwise it may cause damage to your
microphone.
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Specifications

ADC:

Dynamic Range:.......cccccceeeeiiiiieeieeciiiee e 116dB, A-weighted
Signal-to-Noise Ratio:..........cccccvveeeeeiiiiieeeee -116dB, A-weighted
THD+N Ratio: ...eeeiiiiiiiciccceeceee -108dB, -1dBFS
DAC:

Dynamic Range: ........ccoveviiiieiiiiiicie e 127dB, A-weighted
Signal-to-Noise Ratio:..........cccceveviieeiiiiein. -127dB, A-weighted
THDHN Ratio: ..eeeeiiiiiieiececee e -120dB, 0dBFS
Mic Input(XLR, Balanced):

Frequency Response: .........ccccevvviiiiincinneenne 20Hz to 20kHz (+/-0.1dB)
NOISE EIN: .ot <-120dB

Input Impedance:.........ccccoovieiiiiiiiicees 1.8K Ohms

Gain RaNge: .....oooveiiiiiee e -6dB~+46dB
Maximum Input Level: ... +9dBu

Instrument Input(6.35mmTS, Unbalanced):

Frequency Response: .........cccccevcviiiiiiecinneenn. 20Hz to 20kHz (+/-0.1dB)
Input Impedance:..........ccccooiiiiiicniices 390K Ohms, typical

Gain Range: ......ocoovvviiiie +6dB~+45dB

Maximum Input Level: ... +9dBu

Line Outputs 1/2 (Stereo, Unbalanced):

Frequency Response: .........cccccveeiiiiiieeeeninnes 20Hz to 20kHz (+/-0.1dB)
Nominal Output Level:...........ccooooiiiiniiiiinieees +6dBu, typical

Maximum Output Level:...........cccccoiiiiiiiieinnes +10dBu

Output Impedance: ........veveveeeeeiiiiiiiiiiic, 150 Ohms

Load Impedance:............cccoeveiiiiiiiiiiiiniieeees 600 Ohm minimum

Headphone Outputs: (Stereo, Unbalanced):

Frequency Response: .........ccccevvveevieeeennennn. 20Hz to 20kHz (+/-1dB)
Maximum Output Level:...........cccoevvieneeeinnns +9dBu, typical

Output Impedance:..........ccccoeevvieeeiiiiiiieeee, 10 Ohms

Load Impedance:..........ccccceoeieiiiiiiciiiiiiees 32 to 600 Ohms



Services

If your UPorts2 Dyna needs servicing, follow these instructions.

Check our online Help Center at http://support.iconproaudio.com/hc/en-us, for
information, knowledge, and downloads such as:

1. FAQ

2. Download

3. Learn More

4. Forum

Very often you will find solutions on these pages. If you don’t find a solution, create
a support ticket at our online Help Center at the link below, and our technical support
team will assist you as soon as we can.

Navigate to http://support.iconproaudio.com/hc/en-us and then sign in to submit
a ticket.

As soon as you have submitted an inquiry ticket, our support team will assist you to
resolve the problem with your ICON ProAudio device as soon as possible.

To send defective products for service:
1. Ensure the problem is not related to operation error or external system devices.
2. Keep this owner's manual. We don't need it to repair the unit.

3. Pack the unit in its original packaging including end card and box. This is very
important. If you have lost the packaging, please make sure you have packed
the unit properly. ICON is not responsible for any damage that occurs due to
non-factory packing.

4. Ship to the ICON tech support center or the local return authorization. See our
service centers and distributor service points at the link below:

If you are located in US

Send the product to:

North America

Mixware, LLC — U.S. Distributor
11070 Fleetwood Street — Unit F.
Sun Valley, CA 91352; USA

Tel.: (818) 578 4030

Contact: www.mixware.net/help

If you are located in Europe
Send the product to:
Sound Service
GmbHEuropean

HeadquarterMoriz-Seeler-Strale

3D-12489 Berlin

Telephone: +49 (0)30 707 130-0
Fax: +49 (0)30 707 130-189
E-Mail: info@sound-service.eu

If you are located in Hong Kong
Send the product to:

ASIA OFFICE:

Unit F, 15/F., Fu Cheung Centre,
No. 5-7 Wong Chuk Yueng
Street, Fotan,

Sha Tin, N.T.,, Hong Kong.
Tel: (852) 2398 2286

Fax: (852) 2789 3947

Email: info.asia@icon-global.
com

For additional update information please visit our website at:

www.iconproaudio.com
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